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Demob  
The Demob User Guide explains how to use the Demob module to assist users in preplanning and 
demobilizing resources. Information entered in Demob is shared with other I-Suite modules, including: 
  

• Resources 

• Incident Action Plan (IAP) 

• Time 

• Cost 

• Supply 
  

Demob Window 

The Demob window is organized in the following manner: 
  

• The Resources Grid displays beneath the toolbars at the top of the window. This 
grid contains a list of the resources currently in the I-Suite database. Click a 
resource in the grid to either view or edit that resource's demobilization 
information. 

• Demobilization information for a resource is defined on the left side of the 
window. If you select a Person resource in the Resources Grid, an Other Quals 
area displays at the bottom of the window in this area.  

• Tentative Release information for a resource displays in the middle section of the 
window. This is the area where all tentative information is entered.  

If you select a Return Travel Method of A/R or AIR in either the Demobilization or Tentative Release 
areas, additional information about air travel displays at the bottom of the window. 

  

• Actual Release information is defined on the right side of the window. This is the 
area where all actual information is entered. 

• The Close button closes the Demob window. 

• The Previous button moves to the previous record in the Resources grid. 

• The Next button moves to the next record in the Resources grid. 

• The Save button saves any changes made to the Demob information 
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Demob Topics 

Topics in this guide  include the following: 
  

• Common Features (See Page 6) 

• Selecting Demob Options (See Page 10) 

• Reviewing Common Data (See Page 16) 

• Define Demob Information (See Page 17) 

• Demob Multiple Resources 

• Tentative Release Poster (See Page 24) 

• Available for Release Report (See Page 26) 

• Air Travel Request Report (See Page 29) 

• Last Work Day Report (See Page 46) 

• Demobilization Checkout Form (See Page 33) 

• Ground Support Report (See Page 38) 

• Actual Demob Report (See Page 36) 

• Other Demob Reports (See Page 41) 

• Demob Reports for Selected Resources (See Page 48)  
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Common Features 
This section describes the menus and toolbars available in the Demob module. 

Menus 

The following drop-down menus display at the top of the I-Suite windows:  
  

File Menu 
The following options are available in the File menu in all modules: 
  

• Open Database - Opens an incident database in I-Suite. 

• Print - Prints the grid in the open module or a report selected on the Reports 
window. 

  

The Print option is not available in the Database Admin module. 

  

• Refresh Data - Refreshes the data on your window. 

• Exit - Closes the I-Suite application. 
  

Modules Menu 
The following options are available in the Modules menu: 
  

• Database Admin - Opens the Database Admin Module. 

• Data Admin - Opens the Data Admin Module. 

• Resources - Opens the Resources Module. 

• Cost - Opens the Cost Module. 

• Supply - Opens the Supply Module. 

• IAP - Opens the Incident Action Plan Module. 

• Demob - Opens the Demob Module. 

• Time - Opens the Time Module. 

• Injury/Illness - Opens the Injury/Illness Module. 
  

Filters Menu 
Select an option from the Filters drop-down menu to filter the Resources grid by:  
  

• Aircraft  

• Crews  

• Equipment  

• Overhead  

• All  
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• All Personnel  
  
  

Reports Menu 
Select an option from the Reports menu to print the following types of reports: 
  

• Cost Reports  

• Demob Reports  

• Plans Reports  

• Supply Reports  

• Time Reports  

• Custom Reports  

• Injury/Illness Reports 
  

Tools Menu 
The following options are available in the Tools menu in all modules: 
  

• Options - Define the settings for the different modules in I-Suite. 
  

The settings you can change in Options depends on the permissions that are assigned to you in the I-
Suite system. 

  

• Quick Stats - Quickly view Stats in the I-Suite system. 

• Change Password - Change your I-Suite password. 
  
  

Help Menu 
The following options are available in the Help menu: 
  

• I-Suite Help - Opens Help information for the I-Suite application. 

• About - Displays version information for I-Suite. 

• Support - Displays contact information for the HelpDesk. 
  

Toolbars 

The following toolbars display at the top of the I-Suite windows: 
  

Main Toolbar 
The Main toolbar contains two separate types of buttons: 
  

Module Buttons 
The Module buttons open modules in the I-Suite system. These buttons are located on the left side of 
the Main toolbar. The following example identifies the buttons and the modules that they open: 
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Action Buttons 
The Action buttons perform an action in one of the I-Suite modules. These buttons are located on the 
right side of the Main toolbar. The following example identifies the buttons and the action that occurs: 

  

 

Filter Toolbar 
The Filter toolbar displays beneath the Main toolbar. Click the buttons in this toolbar to filter the 
information in the Resources grid. The following example identifies the buttons in this toolbar and the 
resources that display in the grid when you click the buttons: 
  

 
  

When the Demob module is open, a Demobed Only checkbox displays beneath the Exclude Filled 
checkbox. This option only displays in the Demob module. 

  

  

Demob Toolbar 
The Demob toolbar displays to the right of the Filter toolbar when you are in the Demob module. The 
following example identifies the buttons in this toolbar. 
  

 
  

• P Button - Click a group of resources in the grid. Then click the P button to change 
the status of the selected group to Pending. . 

• D Button - Click a group of resources in the grid. Then click the D button to 
change the status of the selected group to Demobed. 
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When you click either the P or D button, the Save button changes to Save & Next. You must click this 
button to save the changed status to the resource. When you click the Save & Next button, the changes 
are saved and the next selected record displays.  

  

• N Button - If you have used the P or D button to change the status of a group of 
resources, you can change the status back by clicking the N button. You must 
click the N button before saving any changes to the resources. If you saved the 
status change to a resource, it will not be changed back to the original status 
code. 

• Demob Report Buttons - Prints the following reports when you click the 
respective buttons: 

o Tentative Poster  

o Available for Release  

o Air Travel Request  

o Check Out  

o Actual Demob  

o Ground Support 

• Resources Selected in Grid - When this checkbox is checked and you click a 
Report Button, the report is generated for the resource selected in the grid. 

  



 

Chapter 3 

  

I-Suite Version 13.01.00 Demob 10 

Selecting Demob Options 

Follow the steps in this section to select the options to use in the Demob area of the I-Suite system: 
  

Also refer to Selecting Demob Checkout Options (See Page 11) and Selecting Travel Questions for 
Demob (See Page 13). 

  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Demob tab. 

3. Click the lower Demob tab. 

 
  

4. Under Resource Grid Columns, hold down the Ctrl key and click to highlight 
each of the columns you want to select. The following columns are available: 
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5. If you want to remove the selected columns from the Demob window, click the 
Hide button. 
 
If you want to display the selected columns on the Demob window, click the Show 
button. 

Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show 
button, it places a checkmark in the checkbox. When you click the Hide button, it removes the checkmark 
from the checkbox. You can also click the checkbox next to a column to either Show or Hide it. 

  

6. To adjust the order in which the columns display on the Demob window, click a 
column. Then click the Move Up or Move Down button to move the column. 

The order in which the columns display under Resource Grid Columns is the order in which they will 
display in the grid. 

  

7. When you have made all of your changes, click the Save button to save the 
changes. Click the OK button to close the Options window.  

Selecting Demob Checkout Options 
Follow the steps in this section to select the checkout options to use in Demob: 
  

Also refer to Selecting Demob Options (See Page 10) and Selecting Travel Questions for Demob (See 
Page 13). 

  

1. From the Tools drop-down, select Options. The Options window displays.  

2. Click the Demob tab to select it. 

3. Click the Check-Out tab to select it. 
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4. Under the Logistics Section, click to check each of the options you want to check 
in the Logistics section of form ICS-221. You can include: 

• Supply Unit 

• Communications Unit 

• Facilities Unit 

• Ground Support Unit 

5. If you want to check the Documentation Unit in the Planning Section of the ICS-
221 form, click to check the Documentation Unit checkbox.  

6. If you want to check the Demob Unit in the Planning Section of the ICS-221 
form, click to check the Demob Unit checkbox. 

7. If you want to check the Time Unit in the Finance Section of the ICS-221 form, 
click to check the Time Unit checkbox.  

8. If you want to checkthe Security Unit in the Other Section of the ICS-221 form, 
click to check the Security Unit checkbox.  
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9. To include additional information in the Other Section of the ICS-221 form, type 
the name of the option in either of the blank boxes under the Other Section. 
When the name is defined, click to check the checkbox next to the option. 

An example of other additional information is Washing Station. 

  

9. When you have made all of your changes, click the Save button to save the 
changes. Then click the OK button to close the Options window.  

Selecting Travel Questions for Demob 
Follow the steps in this section to define the Air Travel Questions to use in the Demob area of the I-
Suite system: 
  

Also refer to Selecting Demob Options (See Page 10) and Selecting Demob Checkout Options (See Page 
11). 

  

Travel Questions only display in Demob if the Travel Method for the selected resource(s) is defined as 
AIR or A/R (Air with Rental) in the Common Data or Tentative Release areas. Travel questions and 
answers print on the Commercial Air Travel Request Form. 

  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Demob tab to select it. 

3. Click the Travel Questions tab to select it. 



  

      
Chapter 3:Selecting Demob Options     

  

I-Suite Version 13.01.00 Demob 14 
  

 
  

4. To display a listed question in the Air Travel grid for Demob, click to check the 
Display checkbox next to the question.  

5. To adjust the order in which a travel question displays, click to select the 
Question, and then click the Move Up or Move Down button to adjust the order. 

6. Click the Save button to save your changes.  

If you uncheck Display for a Travel Question, the responses to the question no longer display. Although 
the responses do not display, they are still saved in the database. 

  

Add New Travel Question 

Follow the steps in this section to add new travel questions for the Air Travel Request: 
  

You must click in the grid for the Add button to display. 

  

1. Click the Add button. 

2. In the Question box, enter your new travel question. 

3. Click to check the Display checkbox, if appropriate. 
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4. Click the Save button to save the new question. 

5. When finished, click the Save button to save your changes. Click the OK button to 
close the Options window. 
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Reviewing Common Data 
This section explains how to review common data in the Demob module. 
  

Information located above the tabs (if any) in the Manage Resource - Edit Mode area is considered the 
Common Data for a Resource. 

  
Follow the steps in this section to review common data from Demob: 
  

1. Click the Demob button to open the Demob window.  

2. In the Resources grid, click to select a resource. 

3. Click the Edit button in the Main toolbar to display the Manage Resource - Edit 
Mode area at the bottom of the window. 

4. Review the following information for completeness and accuracy: 

• *Request Number 

• *Account Code 

• Person - checked, if applicable 

• Contracted - checked, if applicable 

• *Resource Name 

• *Kind/Position 

• Trainee - checked, if applicable 

• *Status 

• Unit ID 

• Agency 

• *Configuration 

• Actual Release Date 

• Actual Release Time 
  

A label preceded by an asterisk (*) indicates that the information is required.  
 
When the Person option is checked, Resource Name is replaced with Last Name and First Name and 
an Other Quals box displays. Only a Last Name or a First Name is required. You do not need to define 
both to save the record. 

  

5. When you have finished reviewing the information, click the Close button. 
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Define Demob Information 
This section explains how to define Demob information for Resources. 
  

Defining Demobilization Information for a Resource 

Follow the steps in this section to define demobilization information for a resource: 
  

1. Click the Demob button to open the Demob window. Demob information is 
defined in the area on the left side of the window.  

 
  

2. In the Resources grid, click the resource for which you want to define 
demobilization information. 

3. Check the following resource data for accuracy or missing information. This 
information is automatically pulled from Resources. You can make changes, if 
needed. 

a. From the Status drop-down list, select the demobilization status to assign to 
the resource. The following options are available: 
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• C - Check-In 

• D - Demobed 

• F - Filled/Not Checked-In 

• P - Pending Demob 

• R - Reassigned 

• S - Staging  

When the D status is selected, the Actual Release Date is required. 

b. Enter the appropriate Demob City. 

c. From the Demob State drop-down list, select the demobilization state. 

d. From the Jetport drop-down list, select the jetport that is being used for the 
demobilization. 

e. From the Travel Method drop-down list, select the method in which the 
resource will be traveling. 

F. Enter the Mobilization Date. 

G. Enter the First Work Day. 

  

When you define the First Work Day and a Length of Assignment (Days), the system automatically 
calculates the demobilization date and inserts it into the Demobilization Date box. To change this date, 
adjust the Length of Assignment Days. This is important if you are creating Demob Reports from the 
Demob data (e.g. Last Day Work). Some Demob Dates may not need to be adjusted to reflect the current 
incident status (e.g. rain putting the fire out). 

  

The system automatically calculates the Number of Days Left by subtracting the Demobilization Date 
from the Current System Date. 

  

g. Enter the Length of Assignment (Days) for the resource. 

h. The Plans Remarks box contains any remarks defined in the Plans Remarks 
box on the Plans tab in Resources. If needed, you can add remarks or make 
changes to the text in the Plans Remarks box. 

i. If the resource is a person, enter the appropriate information in the Other 
Quals area. 

4. When finished, click the Save button to save your changes. 

If you need to edit Common Data that does not appear on the Demob window (e.g. Unit ID), click the 
resource in the grid. Then click the Edit button in the Main toolbar. Edit the information in the Manage 
Resource - Edit Mode area that displays. Follow Team protocol or Standard Operating Procedures when 
editing data. 

  

Defining Tentative Release Information  

Follow the steps in this section to define Tentative Release information for the resource: 
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1. In the Resources grid, click to select the resource for which you want to define 
tentative release information. Tentative Release information is defined in the 
middle area of the window. 

 
2. If the resource is available for reassignment, click to check the Available for 

Reassignment checkbox.  

When the Available for Reassignment checkbox is checked, Y (for Yes) displays in the Available for 
Release Report. Additional Quals are then listed. 

  

3. Enter the Tentative Release Date for the resource. 

When this is defined, the resource is listed on the Tentative Poster and Available for Release Report. 

  

4. Enter the Tentative Release Time for the resource. 

5. From the Return Travel Method drop-down list, select the most likely method of 
travel the resource will use to return from assignment. (Auto-fills from Common 
Data.) 

If the Return Travel Method is different from the Arrival Travel Method, make sure you change the 
entry in this box. This is important when you are creating Travel Method Reports. 

  

6. In the Remarks box, enter any remarks related to the tentative release. If needed, 
you can click the Remarks button to add or review additional remarks. 

Remarks do not print on the Available for Release Report. 

  

7. If dispatch was notified, click to check the Dispatch Notified checkbox.  

When the Dispatch Notified checkbox is checked, the resource will no longer be included in the 
Available for Release Reports. The assumption is that the report will be faxed to Dispatch. This 
resource should not be sent again. If the resource needs to be sent again, click to check the Resources 
Selected in Grid checkbox, then select the resource in the grid. Click the Available for Demob button to 
print the report again. 
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8. If the Return Travel Method is A/R or AIR, a Travel area displays at the bottom 
of the window.  
 

 
Complete the following steps: 

  

a. Enter the Name on Picture ID for the resource. Because of Airline 
security, the resource must have a legal name on their reservations. 

If the Name on Picture ID is not defined, the resource's Name will NOT print on the Air Travel Request 
form.  

  

b. Select the jetport method from the Depart from Jetport drop-down list. 
This is the jetport from which the resource is departing. 

c. Enter the Travel Time from ICP to Airport in the (Hours) and 
(Minutes) boxes. This information is important for Ground Support 
when scheduling shuttles to the airport. 

d. If you want to add special instructions for the tentative release, enter 
them in the Special Instructions box. Click the Special Instructions 
button to add even more instructions. 

Special Instructions print on the Commercial Air Travel Request Form. However, you can only fill the 
window 1/3 in order for the information to print on the form. Preview the form and make adjustments to 
the information before printing. 

  

e. If there will be air travel to the dispatch, click to check the Air 
Travel to Dispatch checkbox.  

f. If you received an itinerary from dispatch, click to check the 
Itinerary Received From Dispatch checkbox.  

g. If the response to any of the Travel Questions is Yes, click to 
check the checkbox next to the question. The Travel Questions 
display in the far right bottom of the Demob window. 

9. When finished, click the Save button to save your changes. 
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Defining Actual Release Information  

Follow the steps in this section to define actual release information for a resource: 
  

1. In the Resources grid, click the resource for which you want to define actual 
release information. Actual Release information is defined in the area on the right 
side of the window. 

 
2. Enter the Actual Release Date for the resource. 

An Actual Release Date cannot be entered unless the Status is D or R. When Actual Release Date is 
more than 5 days after the system date a warning message will be displayed.  

3. Enter the Actual Time of Departure for the resource. 

4. Enter the Estimated Date of Arrival for the resource. 

An Estimated Date of Arrival cannot be entered unless the Status is D or R. When Estimated Date of 
Arrival is more than 5 days after the system date a warning message will be displayed.  

3. Enter the Estimated Time of Arrival for the resource. 

4. If the resource is expected to rest overnight, click to check the Rest Over Night 
checkbox.  

When the Rest Over Night checkbox is checked, the system prints RON location information on the 
Actual Release Report. 

  

7. In the Remarks box, type any remarks that relate to the actual release of the 
resource. Click the Remarks button to add or view additional remarks. 

Remarks do not print on the Actual Release Report. 
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8. If dispatch was notified about the release, click to check the Dispatch Notified 
checkbox.  

When the Dispatch Notified checkbox is checked, the resource will no longer be included in the 
Available for Release Reports. The assumption is that the report will be faxed to Dispatch. This report 
should not be sent again for the resource. If the report needs to be sent again, click to check the 
Resource Selected in Grid checkbox, then select the resource in the grid. Click the Available for 
Demob button to print the report again. 

  

9. When finished, click the Save button to save your changes. 
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Change Status for Multiple Resources 
This section explains how to change the status of multiple Resource's to either Pending Demob or 
Demob. 
  

Changing the Status to Pending Demob 

Follow the steps in this section to change the status of multiple resources to Pending Demob: 
  

1. In the Resource's grid, select the resources for which you want to change the 
Status to Pending Demob. 

2. Click the P button. This opens the first selected resource in Edit mode and 
defaults the status to P (Pending Demob). 

3. Click the Save and Next button. Each time you click the Save and Next button, 
the system saves the status change and any other changes made to the demob 
information. The system then automatically moves to the next selected resource 
and defaults the status for that resource to P. 

  

Changing the Status to Demobed 

Follow the steps in this section to change the status of multiple resources to Demobed:  
  

1. In the Resource's grid, select the resources that you want to demob. 

2. Click the D button. This opens the first selected resource in Edit mode and 
defaults the status to D (Demobed). 

3. Enter the Actual Release Date for each Resource you are demobing. 

4. Click the Save and Next button. Each time you click the Save and Next button, 
the system saves the status change and any other changes made to the demob 
information. The system then automatically moves to the next selected resource 
and defaults the status for that resource to D. 
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Tentative Release Poster 
This section explains how to print a Tentative Release Poster. This report identifies those resources that 
are tentatively ready to be released. The Tentative Release Poster is sorted by request category and then 
by request number. 
  

Tentative Poster Requirements 

Only those resources that meet the following requirements are included in the report, unless the 
Resources Selected In Grid checkbox is checked:  
  

If the Resources Selected in Grid checkbox is checked, the report prints for those Resources selected 
in the grid, regardless of the requirements. 

  

• The Resource Type is C, E, O or A.  

• The Resource contains a Tentative Release Date and Time.  
  

If the Tentative Poster does not print, double check the Tentative Release Date and Time. This 
information is critical for generating the Poster. 

  

• The Release Date is within a specified date range (when using a date range).  

• The Status is NOT D (Demob). 
  

Generating Tentative Poster from Demob 

Follow the steps in this section to generate a Tentative Demob Poster from the Demob window: 
  

1. Click the Demob button to open the Demob window. 

2. Click to check the Resources Selected in Grid checkbox. 

3. In the Resources grid, click each of the resources you want to include in the 
Tentative Poster. 

4. Click the Tentative Poster button to print a report for the current date. The report 
displays in the Preview window.  

5. Click the Print Report button to print the report. 
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Generating Tentative Poster from Demob Report 

Follow these steps to print a Tentative Demob Poster from the Demob Report window: 
  

1. On the Demob window, click the Reports button in the Main toolbar. 

2. Click the Tentative Poster option to display those Report Settings. 

 
  

These report settings also display if the Resources Selected in Grid checkbox is not checked, and you 
click the Tentative Poster button on the Demob window. 

  

3. Enter the Date Range to include in the report. You can either type the dates or 
select them from the drop-down lists. 

4. If you want to include strike team/task force components in the report, click to 
check the Include strike team/task force components checkbox. 

5. If you want to preview the report before you print it, click the Preview button. Then 
click the Print Report button to print the report. 
 
If you want to print the report without previewing it, click the Print button. Then 
click the Print button on the Print window that displays. 
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Available for Release Report 
This section explains how to print an Available for Release Report. This report identifies those 
resources that are available for release.  

Available for Release Report Requirements 

Only those resources that meet the following requirements are included in the report, unless the 
Resources Selected In Grid checkbox is checked:  
  

If the Resources Selected in Grid checkbox is checked, the report prints for those Resources selected 
in the grid, regardless of the requirements. 

  

• The Resource Type is C, E, O, or A 

• This Resource Status is P (Pending) 

• The Dispatch Notified checkbox is NOT checked for the Resource 

• The Resource contains a Tentative Release Date and Time 

If the Available for Release report does not print for the resource, double check the Tentative Release 
Date and Time. This information is critical for generating this report. 

  

Generating Available for Release Report from Demob 

Follow the steps in this section to generate an Available for Release Report from the Demob window: 
  

1. Click the Demob button to open the Demob window.  

2. Click the Available for Release button on the Demob toolbar.  

3. The Preview window displays with the report. To print the report, click the Print 
Report button.  

4. When the prompt displays asking whether you want to automatically check the 
Dispatch Notified of Tentative Release checkbox, click the Yes button if you 
want to check it. Click the No button if you do not want to check it.   

5. When the Print window displays, click the Print button to print the report. 

  

After printing the report, fax each page of the report to dispatch, as appropriate.  
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Generating Available for Release Report from Demob Reports 

Follow the steps in this section to generate an Available for Release Report from the Demob Reports 
window: 
  

1. On the Demob window, click the Reports button in the Main toolbar to open the 
Demob Reports window.  

2. Click the Available for Release option to display to display those Report 
Settings. 

 
3. To include strike team/task force components in the report, click to check the 

Include strike team/task force components checkbox. 

4. To preview the report, click the Preview button. You can then print the report from 
the Preview window by clicking the Print Report button. 
 
To print the report without previewing it, click the Print button on the Select 
Reports window.  

5. When the prompt displays asking whether you want to automatically check the 
Dispatch Notified of Tentative Release checkbox, click the Yes button if you 
want to check it. Click the No button if you do not want to check it. 
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Reprinting the Available for Release Report 

If you need to reprint the Available for Release Report, follow these steps: 
  

1. From the Reports drop-down menu, select Demob Reports. The Select Reports 
window displays with the Demob tab selected.  

2. Click the Available for Release option to display the Report Settings. 

 
3. Under Report Settings, click to check the Reprint Report checkbox. 

4. From the Date Time Printed drop-down list, select the date for the report that you 
want to reprint.  

5. To print a new date on the report, click to check the New Print Date checkbox. 

6. To preview the report, click the Preview button. You can then print the report from 
the Preview window by clicking the Print Report button. 
 
To print the report without previewing it, click the Print button on the Select 
Reports window. The Dispatch Notified of Tentative Release window displays. 

7. When the prompt displays asking whether you want to automatically check the 
Dispatch Notified of Tentative Release checkbox, click the Yes button if you 
want to check it. Click the No button if you do not want to check it. 
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Air Travel Request Report 
This section explains how to create an Air Travel Request Form. This is a form that people can use to 
request commercial air travel.  
  

Air Travel Request Report Requirements 

A form only prints for those resources that meet the following requirements, unless the Resources 
Selected In Grid checkbox is checked:  
  

If the Resources Selected in Grid checkbox is checked, the report prints for those Resources selected 
in the grid, regardless of the requirements. 

  

• The Resource Status is P (Pending). 

• The Return Travel Method for the Resource is A/R or Air. 

If the Resources Selected in Grid checkbox is checked, and you select a resource with a Return Travel 
Method other than A/R or Air, the resource's Name will NOT print on the Air Travel Request. 
 
Because the Name on the Air Travel Request must be the same as the Name defined on the resource's 
Picture ID, the name will not print on the Air Travel Request unless A/R or Air are the Return Travel 
Method and the Name on Picture ID is defined for the Resource. 

  

• The Air Travel to Dispatch checkbox is NOT checked. 

  
The following Tentative Release information must be defined to avoid printing blank fields in the 
Commercial Air Travel Request form: 
  

• Tentative Release Date and Time 

• Resource Name (May auto-fill - check against the name on the resource's 
picture ID. Fill-in if this does not auto-fill.) 

• Departing Airport Code (usually closes to incident or where rental car was 
rented.) 

• Special Remarks (e.g. aisle seat because leg is in split.) 

• Travel Time (minutes) from the incident to the Departure airport 

• Travel Questions - Click to check the checkbox next to each question for which 
a Yes response is appropriate. All questions and answers print. 

The following additional items will print on the form if the data was entered: 
  



  

      
Chapter 8:Air Travel Request     

  

I-Suite Version 13.01.00 Demob 30 
  

• Resource Name 

• Demob City, State 

• Jetport (arrival airport from check-in information) 

• If the Reassignment checkbox was checked under Tentative Release on the 
Demob window: 

o Reassignment Pending Demob prints in the upper right corner. If the 
checkbox is not checked, only Demob prints. 

o Last Date Available to Work (of 14 day tour). This is based on the 
Length of Assignment entry, which is used to calculate the remaining 
days of the tour. The Last Day Available to Work is the last day of the 
tour. 

• Other Quals will be listed. 

  

Generating Air Travel Request from Demob 

Follow the steps in this section print an Air Travel Request Report from the Demob window: 
  

1. Click the Demob button to open the Demob window.  

2. Click the Air Travel Request button.  

3. The report displays in the Preview window. Click the Print Report button to print 
the report.  

4. When the prompt displays asking whether you want to automatically check the Air 
travel to Dispatch checkbox, click the Yes button to check it. Click the No button 
if you do not want to check it.  

5. When the Print window displays, click the Print button to send the report to the 
printer. 

6. After printing the report, fax each page of the report to dispatch. 

7. When the Air Travel Itinerary is received from dispatch, click to check the 
Itinerary Received from Dispatch checkbox for the appropriate Resource(s). 

  

Only generate and print one resource's Commercial Air Travel Request at a time. A separate form will 
print for each Resource.  

  

Only Special Instructions print on this report. The expanded Special Instructions window can only be 
filled about 1/3 full for all of the information to print on the form. Preview the form to make sure all of the 
appropriate information displays. 

  

The application does not automatically check the Itinerary Received from Dispatch checkbox. This is a 
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manual operation. Use this box to track progress on air travel. 

  

Generating Air Travel Request from Demob Reports 

Follow the steps in this section to generate an Air Travel Request from the Demob Reports window: 
  

1. On the Demob window, click the Reports button in the Main toolbar to open the 
Demob Reports window.  

2. Click the Air Travel Request option to display those Report Settings. 

 
  

3. To include strike team/task force components in the report, click to check the 
Include strike team/task force components checkbox. 

4. If you want to preview the report before you print it, click the Preview button. Then 
click the Print Report button to print the report. 
 
If you want to print the report without previewing it, click the Print button. Then 
click the Print button on the Print window that displays. 

5. When the prompt displays asking whether you want to automatically check the Air 
travel to Dispatch checkbox, click the Yes button to check it. Click the No button 
if you do not want to check it. 

Only generate and print one resource's Commercial Air Travel Request at a time. A separate form will 
print for each resource. 
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Only Special Instructions print on this report. The expanded Special Instructions window can only be 
filled about 1/3 full for all of the information to print on the Commercial Air Travel Request Form. 
Preview the form to make sure all of the appropriate information displays. 

  

The application does not automatically check the Itinerary Received From Dispatch checkbox. This is a 
manual operation to track progress on air travel. 
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Demobilization Checkout Form 
This section explains how to create a Demobilization Checkout Form. The Demobilization Checkout 
Form (ICS-221) must be completed for a resource that is being demobilized.  
  

Demobilization Checkout Form Requirements 

Demobilization Checkout Forms are only generated for resources that do NOT have a checkmark in the 
Checkout Form Printed checkbox, unless the Resources Selected In Grid checkbox is checked.  
  

If the Resources Selected in Grid checkbox is checked, the report prints for those Resources selected 
in the grid, regardless of the requirements. 

  

Generating Checkout Form from Demob  

Follow the steps in this section to generate the Checkout Form from the Demob window: 
  

1. Click the Demob button to open the Demob window.  

2. Click the Check Out button.  

If you click the Checkout button and the Resources Selected in Grid option is NOT checked, a 
message displays indicating that All Resources That Have Not Had a Checkout Form Printed Will Be 
Printed. If you click the Yes button to continue, a checkout form is printed for all of those resources. The 
forms do not print in any particular order. Make sure this is what you want to do before clicking the Yes 
button. 

  

If you want to print individual forms, rather than all of them, click to check the Resources Selected in 
Grid option. In the Resources grid, click each of the resources you want to include, then click the Check 
Out button to generate the forms. 

  

3. The report displays in the Preview window. To print the report, click the Print 
Report button.  

4. When the prompt displays asking whether to automatically check the Checkout 
Form Printed checkbox, click Yes to check it. Click No if you do not want to 
check it.  

5. When the Print window displays, click the Print button to send the report to the 
printer. 
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To change the signoff boxes that are automatically checked, follow the instructions for customizing the 
Checkout Form in Selecting Demob Checkout Options (See Page 11). 

  

Generating Checkout Forms from Demob Reports  

Follow the steps in this section to generate the Checkout Form from the Demob Reports window: 
  

When you print checkout forms from the Demob Reports window, a message displays indicating that All 
Resources That Have Not Had a Checkout Form Printed Will Be Printed. If you click the Yes button 
to continue, a checkout form is printed for all of those resources. The forms print in the order defined 
under Sort. 

  

If you want to print individual forms, rather than all of them, click the Resources Selected in Grid option 
on the Demob window. In the Resources grid, click to select each resource to include, then click the 
Check Out button.  

  

1. On the Demob window, click the Reports button in the Main toolbar to open the 
Demob Reports window. 

2. Click the Checkout Form option to display those Report Settings. 

 
  

3. Under Sort, double click to select each sort to use in the report. The sort order is 
based on the order in which you select the sort options. 

To remove a selected sort, click the sort you want to remove in the right column under Sort. Then click 
the < button. 
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4. To customize the Checkout Form, click the Customize Checkout Form button. 
Then follow the instructions in the options section. (See Selecting Demob 
Checkout Options on Page 11) 

5. To include strike team/task force components, in the report, click to check the 
Include strike team/task force components checkbox. 

6. If you want to preview the report before you print it, click the Preview button. Then 
click the Print Report button to print the report. 
 
If you want to print the report without previewing it, click the Print button. Then 
click the Print button on the Print window that displays. 

After a checkout form prints for a resource, the Checkout Form Printed checkbox in the Tentative 
Release area is checked. This prevents the form from being printed again. If you need to print another 
form for that resource, click to check the Resource Selected in Grid checkbox. In the Resources grid, 
click to select the resource, then click the Check Out button. 
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Actual Demob Report 
This section explains how to create an Actual Demob Report. This report identifies those resources that 
have been released for demobilization.  

Actual Demob Report Requirements 

Only those resources that meet the following requirements are included in the report, unless the 
Resources Selected In Grid checkbox is checked:  
  

If the Resources Selected in Grid checkbox is checked, the report prints for those resource(s) selected 
in the grid, regardless of the requirements. 

  

• The Resource contains an Actual Release Date and Time.  

If the Actual Demob Report does not print for the resource, double check the Actual Release Date and 
Time. This information is critical for generating this report. 

  

• The Dispatch Notified of Actual Release checkbox is NOT checked.  

  

Generating Actual Demob Report from Demob 

Follow these steps to print an Actual Demob Report from the Demob window: 
  

A new page is generated for each request category on the Actual Demob Report. 

  

1. Click the Demob button to open the Demob window.  

2. Click the Actual Demob button.  

3. When you click the Actual Demob button, the Preview window displays with the 
report. To print the report, click the Print Report button.  

4. When the prompt displays asking whether to check the Dispatch Notified of 
Actual Release checkbox, click Yes to check it. Click No if you do not want to 
check it.  

5. When the Print window displays, click the Print button to print the report. 

6. After printing the report, fax each page of the report to dispatch. 
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Generating Actual Demob Report from Demob Reports 

Follow these steps to print an Actual Demob Report from the Demob Reports window: 
  

1. On the Demob window, click the Reports button in the Main toolbar to open the 
Demob Reports window. 

2. Click the Actual Demob option to display the Report Settings. 

  
  

3. To include strike team/task force components in the report, click to check the 
Include strike team/task force components checkbox.  

4. If you want to preview the report, click the Preview button. To print the report on 
the Preview window, click the Print Report button. 
 
To print the report without previewing it, click the Print button on the Select 
Reports window. 

5. When the prompt displays asking whether to check Dispatch Notified of Actual 
Release checkbox, click Yes to check it. Click No if you do not want to check it. 

6. When the Print window displays, click the Print button to send the report to the 
printer. 

7. After printing the report, fax each page of the report to dispatch. 

  



 

Chapter 11 

  

I-Suite Version 13.01.00 Demob 38 

Ground Support Report 
This section explains how to create a Ground Support Report. This is a form that people can use to 
request ground support transportation.  
  

Ground Support Report Requirements 

A form only prints for those resources that meet the following requirements, unless the Resources 
Selected In Grid checkbox is checked:  
  

If the Resources Selected in Grid checkbox is checked, the report prints for the Resource(s) selected in 
the grid, regardless of the requirements. 

  

• The Resource Status is NOT D (Demobed).  

• The Resource contains a Tentative Release Date.  

If the Ground Support Report does not print for the resource, double check the Tentative Release Date 
and Time. This information is critical for generating this report. Leave ICP Time is generated by the 
Tentative Release Time in the Resource record. 

  

• The Return Travel Method for the Resource is A/R or Air.  

• The checkbox Is Ground Support transportation needed? is checked. 

• The Tentative Release Date is within a specified date range (when using a 
date range). 

The Form Date is generated by the Tentative Release Date(s) selected in the Date Range. All flight 
information has to be hand entered and is based on the itineraries received from dispatch. 

  

Generating Ground Support Report from Demob 

Follow these steps to print a Ground Support Report from the Demob window: 
  

1. Click the Demob button to open the Demob window. 

2. Click to check the Resources Selected in Grid option. 

3. In the Resources grid, click each resource to include in the report. 

4. Click the Ground Support button to print a report for the current date. The report 
displays in the Preview window.  
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5. Click the Print Report button to print the report. 

  

Generating Ground Support Report from Demob Report 

Follow these steps to print a Ground Support Report from the Demob Report window: 
  

1. On the Demob window, click the Reports button in the Main toolbar to open the 
Demob Reports window. 

2. Click the Ground Support option to display the Report Settings. 

 
  

These Report Settings also displays when the Resources Selected in Grid checkbox is not checked, 
and you click the Ground Support button on the Demob window. 

  

3. Enter a Date Range to include in the report. If you only want to include one date, 
enter the same date into both boxes. 

4. If you want to preview the report, click the Preview button. To print the report on 
the Preview window, click the Print Report button. 
 
To print the report without previewing it, click the Print button on the Select 
Reports window. 

5. When the Print window displays, click the Print button to send the report to the 
printer. 
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A separate report prints for each date there are resources needing transportation. 
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Other Demob Reports 
This section explains how to print standard Demob reports. 

Print Standard Demob Reports 

I-Suite has a number of features that allow you to produce standard reports. Follow the steps in this 
section to print Demob Reports.  
  

1. On the Demob window, click the Reports button in the Main toolbar to open the 
Demob Reports window.  

3. Click to select one of the following reports: 

• Checkout Form (See Demobilization Checkout Form on Page 33) 

• Demob Planning Report (See Demob Planning Report on Page 41) 

• Mob/Demob Report (See Mob/Demob Report on Page 43) 

• Qualifications Report (See Qualifications Report on Page 44) 

• Section Report (See Section Report on Page 45) 

• Tentative Poster (See Tentative Release Poster on Page 24) 

• Available for Release (See Available for Release Report on Page 26) 

• Air Travel Request (See Air Travel Request Report on Page 29) 

• Last Work Day (See Last Work Day Report on Page 46) 

• Actual Demob (See Actual Demob Report on Page 36) 

• Ground Support (See Ground Support Report on Page 38) 
  

Demob Planning Report 

This report identifies resources and their current status for the incident. To generate a Demob Planning 
Report, complete the following steps: 
  

1. On the Demob Reports window, click Demob Planning Report to display the 
Report Settings. 
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2. Under Select, click to select one of the following resource categories to include in 
the report: 

• Checked-in, pending, staging 

• Demobed, reassigned 

• Pending demob 

• Not demobed 

• Filled 

• Unfilled 

• All resources 

3. Under Sort, double click to select each sort to use in the report. The sort order is 
based on the order in which you select the sort options. 

To remove a selected sort, click the sort you want to remove in the right column under Sort. Then click 
the < button. 

  

4. To include strike team/task force components, click to check the Include strike 
team/task force components checkbox. 

5. To include subtotals on the first sort, click to check the Include subtotals on first 
sort checkbox. 
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6. To include strike team/task force components in the report, click to check the 
Include strike team/task force components checkbox. 

7. To preview and then print the report, click the Preview button. Then click the Print 
Report button. 

8. To print the report without previewing, click the Print button. 

  

Mob/Demob Report 

This report identifies those resources that were demobilized. To generate a Mob/Demob Report, 
complete the following steps: 
  

1. On the Demob Reports window, click Mob/Demob Report to display the Report 
Settings. 

 
  

2. Click one of the following options to identify how information is organized in the 
report: 

• By Section - This option groups by section and then sorts the 
information by Demob Date and then Request Number. 

• By Resource Kind - This option groups by Kind Categry and then sorts 
by Kind Code, Demob Date and then Request Number. 
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• By Demobilization Date - There is no grouping with this option. The 
data is sorted by Demob Date, Kind Code and then Request Number. 

3. To include strike team/task force components in the report, click to check the 
Include strike team/task force components checkbox. 

4. To preview and then print the report, click the Preview button. Then click the Print 
Report button. 

5. To print the report without previewing, click the Print button. 

  

Qualifications Report 

This report identifies the positions/kind codes defined in the I-Suite system and those resources that are 
assigned to the positions. To generate a Qualifications Report, complete the following steps: 
  

1. On the Demob Reports window, click Qualifications Report to display the 
Report Settings. 

 
  

2. To include All Kinds in the report, click to check the All Kinds checkbox. 
 
To include specific kind codes in the report, double click the code you want to 
include to move it from the Kind Codes list to the Selected Kinds list. 

To search for a code listed under Kind Codes, enter the code in the Kind Search box. The application 
automatically highlights the code that matches your search term. Double click the kind code or click the 
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>> button to add it to the Selected Kinds list. 

  

3. If you do not want to include trainees in the report, click to check the Exclude 
Trainees checkbox. 

4. If you only want to include trainees in the report, click to check the Trainees Only 
checkbox. 

5. To preview and then print the report, click the Preview button. Then click the Print 
Report button. 

6. To print the report without previewing, click the Print button. 

  

Section Report 

This report identifies those resources assigned to different sections (i.e. Command Staff, Operations 
Section, etc.). To print a Section Report, complete the following steps: 
  

1. On the Demob Reports window, click Section Report to display the Report 
Settings. 

 
  

2. Under Sort, double click to select each sort to use in the report. The sort order is 
based on the order in which you select the sort options. 

The RequestNumber sort is automatically added as the first sort for theSection Report. When the sort is 
set to RequestNumber, the information in the report is grouped by O, C, A, and E Request Numbers. 
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To remove a selected sort, click the sort you want to remove in the right column under Sort. Then click 
the < button. 

  

3. To include strike team/task force components, click to check the Include strike 
team/task force components checkbox. 

4. To preview and then print the report, click the Preview button. Then click the Print 
Report button. 

5. To print the report without previewing, click the Print button.  

  

Last Work Day Report 

This report identifies those resources with last work days within a defined date range. Only those 
resources that meet the following requirements are included in the report: 
  

• A Tentative Release Date or Demobilization Date is defined. 

• The calculated Last Work Day falls within the defined date range. 

• An Actual Release Date is not defined. 

• The Status is not D (Demobed). 
  
To print a Last Work Day Report, complete the following steps: 
  

1. On the Demob Reports window, click Last Work Day Report to display the 
Report Settings. 
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2. Under Grouping, click to select one of the following options: 

• Date,RequestCat - Select this option to group the data in the report by the 
Last Work Date and then Request Category. 

• Section,Date - Select this option to group the data in the report by the Section 
and then Last Work Date. 

• Section,RequestCat,Date - Select this option to group the data in the report 
by the Section, Request Category and then the Last Work Date. 

3. In the Date Range boxes, enter the range of dates to include in the report. To only 
include one date in the report, enter the same date into both boxes. 

4. When either the Section,Date or Section,RequestCat,Date are selected, identify 
the sections to include in the Last Work Day report.  

All Sections are automatically selected. If you do not want to include a section, click to uncheck that 
section. 

  
The following sections are available for the report: 

• Command 

• External Res 

• Finance 

• Logistics 

• Operations 

• Plans 

If you are in a 2007 database that was upgraded, an Area Command and a Medical section are also 
available. 

  

5. Under Sort, click to select a sort to use in the report, and then click the right 
arrow(>) button. Repeat this process for each sort to include in the report. The sort 
order is based on the order in which you select the sort options. 

6. To include strike team/task force components in the report, click to check the 
Include strike team/task force components checkbox. 

7. To preview and then print the report, click the Preview button. Then click the Print 
Report button. 

8. To print the report without previewing, click the Print button. 
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Demob Reports for Selected Resources  
This section explains how to generate a Demob report for resources selected in the grid.  
  

1. Click the Demob button to open the Demob window.  

2. Click to check the Resources Selected in Grid checkbox.  

3. In the Resources grid, click the resource(s) for which you want to create the 
Demob Report.  

4. On the Demob tool bar, click the appropriate report button to identify the report 
you want to print. 

5. To print the report from the Preview window, click the Print Report button.  

6. On any Message windows that display, click to select the appropriate response. 

7. When the Print window displays, select the printer where you want to send the 
report, and then click the Print button.  
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Demob Report Descriptions 
The following Demob Reports are available in I-Suite: 
  

Demobilization Checkout Form 

The Demobilization Checkout Form must be completed for a resource that is being demobilized. 
Demobilization Checkout Forms are only generated for resources that do NOT have a checkmark in the 
Checkout Form Printed checkbox. 
  

Demob Planning Report 

This report identifies resources and their current status for the incident. You can print the report for: 
  

• resources that are checked-in, pending, or in staging, 

• demobed or reassigned resources, 

• resources pending demob, 

• resources that were not demobed, 

• filled resource assignments, 

• unfilled resource assignments, 

• or all resources 
  

Mob/Demob Report 

This report identifies those resources that were demobilized. You can print this report by: 
  

• Section,  

• Resource/Kind,  

• or Demobilization Date. 
  

Qualifications Report 

This report identifies the positions/kind codes defined in the I-Suite system and those resources that are 
assigned to the positions. The information in this report includes: 
  

• the position and kind code, 

• the request number assigned to the resource, 

• the name of the resource assigned to the position, 
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• identification of trainee resources, 

• the code for the agency assigned to the resource, 

• the section assigned to the resource, 

• and the demobilization date for the resource. 
  

Section Report 

This report identifies those resources assigned to different sections (i.e. Command Staff, Operations 
Section, etc.). 
  

Tentative Poster 

This report identifies those resources that are tentatively ready to be released. Only those resources that 
meet the following requirements are included in the report: 
  

• The Resource Type is C, E, O or A. 

• The Resource contains a Tentative Release Date. 

• The Tentative Release Date is within a specified date range. 
  

Available for Release 

This report identifies those resources that are available for release. Only those resources that meet the 
following requirements are included in the report: 
  

• The Resource Type is C, E or O. 

• The Resource Status is P (Pending). 

• The Dispatch Notified checkbox is not checked. 
  

Air Travel Request 

This is a form that people can use to request commercial air travel. A form only prints for those resources 
that meet the following requirements: 
  

• The Resource Status is P (Pending). 

• The Return Travel Method for the resource is A/R or Air. 

• The Air Travel to Dispatch checkbox is not checked. 
  

Last Work Day 

This report identifies those resources with last work days within a defined date range. Only those 
resources that meet the following requirements are included in the report: 
  

• A Tentative Release Date or Demobilization Date is defined. 

• The calculated Last Work Day falls within the defined date range. 
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• An Actual Release Date is not defined. 

• The Status is not D (Demobed). 
  

Actual Demob 

This report identifies those resources that have been released for demobilization. Only those resources 
that meet the following requirements are included in the report: 
  

• The Resource Status is not D (Demobed). 

• The Resource contains an Actual Release Date and Time. 

• The Dispatch Notified of Actual Release checkbox is not checked. 
  

Ground Support 

This is a form that people can use to request ground support transportation. A form only prints for those 
resources that meet the following requirements: 
  

• The Resource Status is P (Pending). 

• The Resource contains a Tentative Release Date and Time. 

• The Return Travel Method for the Resource is A/R or Air. 

• The Is Ground Support transportation needed? checkbox contains a check. 
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Revision History 
Revision Date  Revision Summary  
2011-03-31 Revised instructions for the 11.01.00 version of I-Suite. 
2010-04-27 Revised instructions for the 10.01.00 version of I-Suite. 
2009-05-01 Revised instructions for the 9.01.00 version of I-Suite. 
2008-04-25 Revised instructions for the 8.01.00 version of I-Suite. 
2007-07-25 Revised instructions for the 7.01.05 version of I-Suite. 
2007-04-20 Revised instructions for 7.01.00 release of I-Suite. 
2007-01-11 Revised instructions based on changes received for Training 

Manuals. 
2006-12-04 Revised instructions by adding more detail and graphics. 
2006-06-12 Added instructions for printing a report for a resource selected in the 

grid. Revised instructions for the 6.02 version of I-Suite. 
2006-04-17 Instructions for new module of the new I-Suite 2006 application. 
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